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Simple Harmonic Motion 
Kinematics and Dynamics of Simple Harmonic Motion 

 
INTRODUCTION 
When you suspend an object from a spring, the spring will stretch. If you pull on the object, 
stretching the spring some more, and release it, the spring will provide a restoring force that will 
cause the object to oscillate in what is known as simple harmonic motion (SHM). In this 
experiment, you will examine this kind of motion from both kinematic and dynamic perspectives. 

OBJECTIVES 
In this experiment, you will 

• Collect position vs. time data as a weight, hanging from a spring, is set in simple harmonic 
motion (SHM).  

• Determine the best-fit equation for the position vs. time graph of an object undergoing 
SHM.  

• Define the terms amplitude, offset, phase shift, period and angular frequency in the context 
of SHM. 

• Predict characteristics of the corresponding velocity vs. time and acceleration vs. time 
graphs, produce these graphs and determine best-fit equations for them. 

• Relate the net force and acceleration for a system undergoing SHM. 
 

MATERIALS 
Vernier data-collection interface ring stand and right angle clamp 
Logger Pro spring 
Vernier Motion Detector mass hanger and standard lab masses  
Vernier Dual-Range Force Sensor or 
  Wireless Dynamic Sensor System  
 

wire basket 
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PRE-LAB INVESTIGATION 
Attach a rod to a vertical support rod using a right angle clamp. Mount a 
Dual-Range Force Sensor (or WDSS) to the horizontal rod. Now hang a 
spring from the hook on the sensor and suspend a mass hanger and weights 
from the spring, as shown in Figure 1. Assume that the bottom of the hanger 
is the zero position. Pull on the mass hanger slightly and release it. Observe 
the motion of the hanger. On the axes below, sketch a graph of the position of 
the hanger as a function of time. 

 

 

   

  
     

 

Compare your sketch to those of others in the class. 

 
PROCEDURE 
1. Connect the Motion Detector and the Dual-Range Force Sensor to the interface connected to 

a computer and start Logger Pro. Three graphs, force vs. time, position vs. time and velocity 
vs. time, will appear in the graph window. For now, delete all but the position-time graph. 
You will be able to insert the others later, when needed. Choose Auto Arrange from the Page 
menu to re-size the graph. 

2. The default data-collection rate is appropriate; however, shorten the duration to 5 seconds. 

3. If your motion detector has a switch, set it to Track. 

4. Hang the mass hanger and masses from the spring. 
Place the motion detector on the floor beneath the mass hanger. Place the wire basket over the 
motion detector to protect it. 

5. Make sure the hanger is motionless, then zero both the force sensor and the motion detector. 

6. Lift the hanger and weights a few centimeters, then release. When the mass hanger is 
oscillating smoothly, start data collection. 

7. If the position-time graph appears to be a smooth curve, autoscale the graph and choose Store 
Latest Run from the Experiment menu. If not, repeat until you obtain a smooth curve. 

8. Perform a second trial, except this time, make the initial displacement of the mass hanger 
different from what you did for your first trial. If the position-time graph does not appear to 
be a smooth curve, repeat until you obtain one.  

Figure 1 
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EVALUATION OF DATA 
Part 1  Exploration of SHM 
1. Compare the position-time graphs you obtained with the one you sketched in the Pre-Lab 

Investigation. In what ways are the graphs similar? In what ways do they differ? What 
function appears to describe the position-time behavior of an oscillating body? 

2. Before you fit curves to your position-time graphs, turn off Connect Points and turn on Point 
Protectors. Since the hanger-mass system moves vertically, double-click on the position 
header in the data table and use y as the short name for position. 

3. Use the curve-fitting features of Logger Pro to fit a sine curve to the data for each of your 
runs. Write the equations that represent the motion of the system for each trial. Be sure to 
record the values of the A, B, C and D parameters in the curve fit.  

4. Compare the values of the A parameter for each of your sine fits. What aspect of the y-t graph 
does A appear to describe? The name given to the A parameter is amplitude. 

5. Unless you managed to begin collecting data at the instant the oscillating mass hanger was 
rising through the 0 position, your y-t graphs are likely to be shifted somewhat from the 
standard position of a graph of 

 

y = sinθ . Delete your curve fits for 
the y-t graphs and choose Curve Fit again for one of your runs. 
After you click Try Fit in the Curve Fit dialog box, switch to 
Manual as the Fit Type, then click OK. Doing so enables you to 
manipulate the parameters in the graph window. When you click 
on the value of C suggested by Logger Pro to fit the data, an 
arrow appears next to C as shown to the right. The up and down 
arrows on your keyboard allow you to change this value. Double-
clicking on this window allows you to specify a value for the parameter or the amount of 
increment. Try increasing and decreasing the value of C by ± 0.1 to see what effect this has on 
the test plot used to fit your data. Return C to its original value. 

6. Since the argument of a sine function must be an angle, the expression Bt + C must have units 
of an angle measure. The values Logger Pro uses for the C parameter are given in radians. 
What must be the units of B? Try changing the value of the suggested B parameter to see 
what effect this has on the number of cycles that appear in the test graph window. The B 
parameter is known as angular frequency, ω. Compare the values of B for your curve fits to 
the y-t data for both of your runs. Discuss the physical significance of this parameter before 
moving on to Part 2.  

Part 2  Rates of change 
In earlier experiments you investigated the relationship between position-time and velocity-time 
graphs for linear kinematics. In this part you will continue this investigation for the more complex 
motion of an oscillating body.  

7. Hide the data set for Run 2. Choose Insert Graph and then do an Auto Arrange under the 
Page menu. Select More on the vertical axis of this graph, choose Velocity for the first run, 
then Autoscale this graph.  

8. Select both graphs and choose Group Graphs (x-axes) to make sure that the time axes are 
aligned. Note the position of the mass hanger when its speed is at a maximum value and again 
when its speed is zero.  
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9. Click on the y-t graph to make it active and turn on the Tangent Tool. On the v-t graph turn 
on the Examine Tool. Move the cursor across the y-t graph; as you do so, compare the slope 
of the tangent to any point on the y-t graph to the value of the velocity on the v-t graph. Write 
a statement describing the relationship between these quantities. When you are finished, de-
select these tools. 

 10. An object’s velocity is the rate of change of its position with respect to time. Logger Pro does 
not measure the velocity of an object; rather it calculates it from the position-time data. 
Double-click on the column header for velocity to see the equation Logger Pro uses to 
determine velocity. Make sure you understand the function and its argument before you move 
on. 

 11. Since cosine is the derivative of the sine (that is, θ
θ

θ cos)(sin
=

d
d ), and velocity is the 

derivative of position, it seems reasonable to use the cosine to fit the velocity-time data. Select 
the v-t graph, choose Curve Fit, then select the sine function as before; this time, however, 
choose Define Function. In the User Defined Function window replace “sin” with “cos” and 
name the function “Cosine”. After you choose Try Fit, check to see how closely the graph of 
this function matches that of your data. You may have to try a fit several times before you 
obtain a nice match. Before you click OK, replace the values of B and C suggested by Logger 
Pro with those used in the sine fit to your y-t graph; make sure the value of A is positive. 

 12. From what you know about the chain rule, determine the value of the coefficient of the cosine 
function when you take the derivative of your sine fit to the y-t graph. Compare this to the A 
parameter suggested by Logger Pro for the fit to the v-t graph. 

 13. Insert a new graph and use the Auto Arrange and Group Graphs features as you did in Steps 7 
and 8. Choose acceleration for your first run as the vertical axis label and Autoscale the graph. 
With all three graphs selected, use the Examine tool to note how the position, velocity and 
acceleration of the hanger change at various times in a given cycle. For example, when the 
hanger is at its maximum height, what are the values of the velocity and acceleration? When 
you are done, turn off the Examine tool. 

 14. From what you know about velocity and acceleration, fit an appropriate function to the 
acceleration-time graph. In order to keep the keep the argument of the function the same as in 
the y-t and v-t graphs, what change do you have to make to parameter A? How does A 
compare to the value of the coefficient you obtain when you find the derivative of the function 
used to fit the v-t graph? 

Part 3  The role of force 
 15. On your v-t graph replace velocity with force as your vertical axis label. Since you zeroed the 

force sensor before you began collecting data, this column in the data table ought to be 
labeled net force. Note how the net force acting on the mass hanger varies as its position 
changes from maximum to minimum. Explain why the net force responsible for SHM is called 
a restoring force. 

 16. Describe how the acceleration of the mass hanger varies as the net force varies through each 
cycle of SHM. Would you expect Newton’s second law to apply to this type of motion? 
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 17. To test whether the net force is proportional to the acceleration in this kind of motion, change 
the horizontal axis of the force-time graph to acceleration, then autoscale the graph. Perform a 
linear fit to the data. Relate the slope to any system parameter that was held constant. 

 18. Consider the components of the oscillating system when you try to explain any discrepancy 
between the value of the slope reported by Logger Pro and the constant of proportionality 
you may have expected. 

 
EXTENSION 
You should have noticed that the B parameter to the sine fit to your y-t data for each of your runs 
was the same. In this activity you will explore aspects of the physical system on which the angular 
frequency ω, depends. 

As you saw in Part 3, Hooke’s law describes the relationship between the restoring force and the 
position of the mass hanger, y. Substitution of this expression for force into Newton’s second law 
yields 

 

−k y = m a . As you saw in Part 2, the acceleration is the second derivative of position with 
respect to time. The previous equation can be written as: 

 

 

−k y = m
d2y
dt 2  

This is a 2nd order differential equation. The solution to such an equation is a function. In this 
experiment, you have found a function for y(t) that neatly describes the motion of the system. 
Substitution of this function in the equation above, rearranging and canceling like terms should 
enable you to derive an equation for ω in terms of k and m. 

When you have done so, predict how you could change the angular frequency of the SHM by 
some simple factor (like doubling or halving). Go back to your experimental setup and test your 
prediction. 

Consider any other factors that may have an effect on the value you obtain for B. After your 
discussion, make the necessary adjustment to the hanging mass to test your prediction and 
perform another run. 
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Motion on an Incline 
INTRODUCTION 
When you examined an object moving with constant velocity in introductory Activity 2, you 
learned two important points about the line of best fit to the graph of position vs. time: 

1. The slope (rate of change) of the graph was constant, and gave the velocity of the object. 

2. The intercept gave the initial position of the object. 

In this experiment, you will examine a different kind of motion and contrast features of the 
position-time and velocity-time graphs with those you have studied earlier. 

OBJECTIVES 
In this experiment, you will 

• Collect position, velocity, and time data as a cart rolls up and down an inclined track.  
• Analyze the position vs. time and velocity vs. time graphs. 
• Determine the best fit equations for the position vs. time and velocity vs. time graphs.  
• Distinguish between average and instantaneous velocity. 
• Use analysis of motion data to define instantaneous velocity and acceleration.  
• Relate the parameters in the best-fit equations for position vs. time and velocity vs. time 

graphs to their physical counterparts in the system. 
 

MATERIALS 
Vernier data-collection interface Vernier Dynamics Track  
Logger Pro or LabQuest App Motion Encoder cart  
Vernier Motion Encoder Receiver books or blocks to elevate track  

 
 
PRE-LAB INVESTIGATION 
Elevate one end of the track. Place the cart at the lower end and 
give it a gentle push so that it moves up the track (without falling 
off) and returns to its starting position. 

On the axes to the right, predict what a graph of the position vs. 
time would look like. Use a coordinate system in which the origin 
is on the left and positive is to the right. 
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PROCEDURE 
1. Connect the Motion Encoder Receiver to the interface and start the data-collection program. 

Two graphs: position vs. time and velocity vs. time will appear in the graph window. For 
now, hide or remove the velocity vs. time graph. Later, during the analysis of data, you will 
add the v-t graph back to your view. 

2. Attach the Motion Encoder Receiver to the end of the track, aligned with the encoder strip. 

3. Elevate the end of the track opposite the Motion Encoder Receiver as directed by your 
instructor. 

4. Practice launching the cart with your finger so that it slows to a stop at least 50 cm from its 
initial position before it returns to the initial position. 

5. Turn on the Encoder Cart. 

6. Hold the cart steady with your finger a little bit away from the Motion Encoder Receiver, 
then zero the Motion Encoder.  

 
 

Figure 1 
7. Begin collecting data, then launch the cart up the ramp. Be sure to catch it once it has 

returned to its starting position. 

8. Repeat, if necessary, until you get a trial with a smooth position-time graph. 

 
EVALUATION OF DATA  
Part 1 
1. Either print or sketch the position vs. time (x-t) graph for your experiment. On this graph 

identify: 
• Where the cart was rolling freely up the ramp 
• Where the cart was farthest from its initial position 
• Where the cart was rolling freely down the ramp 

 
2. In your investigation of an object moving at constant velocity, you learned that the slope of 

the x-t graph was the average velocity of the object. In this case, however, the slope for any 
interval on the graph is not constant; instead, it is constantly changing. Based on your 
observations, sketch a graph of velocity vs. time corresponding to that portion of the x-t 
graph where the cart was moving freely. 
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3. Now, view both the position vs. time and velocity vs. time graphs. Compare the v-t graph to 
the one you sketched in Step 2.  

4. Take a moment to think about and discuss how you could determine the cart’s velocity at any 
given instant. 

5. If you are using Logger Pro, group the two graphs (x-axis), and turn on the Tangent tool for 
the x-t graph and the Examine tool for the v-t graph. (In LabQuest App, simply turn on the 
Tangent tool). Using either program, compare the slope of the tangent to any point on the x-t 
graph to the value of the velocity on the v-t graph. Write a statement describing the 
relationship between these quantities. 

Part 2 
1. Perform a linear fit to that portion of the v-t graph where the cart was moving freely. Print or 

sketch this v-t graph. Write the equation that represents the relationship between the velocity 
and time; be sure to record the value and units of the slope and the vertical intercept.  
On this v-t graph identify: 
• Where the cart was being pushed by your hand 
• Where the cart was rolling freely up the ramp 
• The velocity of the cart when it was farthest from its initial position 
• Where the cart was rolling freely down the ramp 
 

2. The slope of a graph represents the rate of change of the variables that were plotted. What 
can you say about the rate of change of the velocity as a function of time while the cart was 
rolling freely? In your discussion, you will give a name to this quantity. What is the 
significance of the algebraic sign of the slope? 

3. Compare the value of your slope to those of others in the class. What relationship appears to 
exist between the value of the slope and the extent to which you elevate the track? 

4. The vertical intercept of the equation of the line you fit to the v-t graph represents what the 
velocity of the cart would have been at time t = 0 had it been accelerating from the moment 
you began collecting data. Suggest a reasonable name for this quantity. Now write a general 
equation relating the velocity and time for an object moving with constant acceleration 

5. The position-time graph of an object that is constantly accelerating should appear parabolic. 
Use the Curve Fit function of your data analysis program to fit a quadratic equation to that 
portion of the x-t graph where the cart was moving freely. Note the values of the A and B 
parameters in the quadratic equation. You will have to provide the units. 

6. Compare these parameters (values and units) to the slope and intercept of the line used to fit 
the v-t graph. Now write a general equation relating the position and time for an object 
undergoing constant acceleration. 
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EXTENSION 
Try repeating the data collection with the same apparatus, but this time, place the Motion 
Encoder Receiver at the top of the track. Interpret your x-t and v-t graphs as you did before. 

 
ANIMATED DISPLAY 
If you are using Logger Pro, inserting an animated display gives you another tool to represent 
both the position and velocity of the cart at a number of instants during the experiment. Your 
instructor will show you how to set up the point display options for such a display. 



 Computer 
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Superelastic Collisions 
You have likely done homework problems and possibly laboratory experiments about collisions. 
Those collisions were probably classified as elastic, inelastic or completely inelastic. In the latter 
case the objects stick together after collision. The collisions are often analyzed in terms of energy 
and momentum conservation. In this experiment you will consider an additional collision class 
called superelastic.  

In the superelastic dynamics cart collision you will create, a trigger will release a spring-loaded 
plunger on impact, propelling the carts apart. The carts have no other horizontal forces acting on 
them, aside from the small amount of friction which can be ignored. 

Will such a collision conserve energy? Why or why not? If not, will the energy increase or 
decrease? And where would it have come from?  

Similarly, will such a collision conserve momentum? Why or why not?  

 
Figure 1 

 
 
OBJECTIVES 

• Create and observe a superelastic collision between two dynamics carts. 
• Predict energy and momentum before and after the superelastic collision. 
• Devise an experiment to check for energy and momentum conservation. 
• Explain how your experimental results support or refute your prediction. 

 
 
MATERIALS 

Computer 
Vernier computer interface 

two Motion Encoder Receivers 
one standard Motion Encoder Cart 

Logger Pro 
Vernier Dynamics Track with two 
   Motion Encoder Track Strips 

one plunger Motion Encoder Cart 
small straight screwdriver 

 
 
PRELIMINARY SETUPS 
1. Level the track.  

2. Configure the plunger cart for superelastic collisions by extending the release button below 
the plunger. Use a small screwdriver as needed.  
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3. Depress and lock the plunger by pressing the bar above the plunger. Test by pressing the 
release button; the plunger should extend. Reset the plunger.  

4. Use the carts to create a superelastic collision. Start with the carts moving slowly before the 
collision. Catch the carts before they leave the track. 

5. Make your predictions concerning energy and momentum conservation described in the 
introductory remarks. 

PROCEDURE 
1. Devise an experimental plan to test your predictions.  

2. Place a Motion Encoder Receiver at each end of the track, as shown in Figure 1. Connect the 
Motion Encoder Receivers to the digital (DIG) ports of the interface. Turn on the carts. 

3. Open the file “18 Momentum Energy Coll” from the Physics with Vernier folder. This 
experiment file is configured to help you record the position as a function of time of two carts 
simultaneously, with a common coordinate system.  

4. Check that you understand how the software is plotting cart positions. Do this by placing the 
two carts at rest in the middle of the track, with transmitters (blue lights) pointing toward the 
receivers. With the plunger extended, place the carts in contact near the middle of the track. 
Click . Select both sensors and click . This procedure will establish the same 
coordinate system and zero for both Encoder Receivers. Verify that the zeroing was 
successful by clicking  and move the carts together along the track. Keep your hands 
out of the region between the transmitters and receivers. The graphs for each Motion Encoder 
should be nearly the same. If not, repeat the zeroing process. 

5. Perform your experiment.   

 
ANALYSIS 
1. Do the experimental data support your prediction concerning momentum conservation? Write 

a paragraph discussing the prediction and the level of agreement of the experimental data. 

2. Do the experimental data support your prediction concerning energy conservation? Write a 
paragraph discussing the prediction and the level of agreement of the experimental data. 
Consider sources of energy in your discussion.  

 
EXTENSIONS 
1. Do you need to know the masses of the carts to perform the experiment? Or is knowing that 

they are the same sufficient?  

2. Make the masses of the carts different. Does that change the conservation behavior of the 
collision? 
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INSTRUCTOR COMMENTS 
1. A typical student experiment will measure the velocity of the two carts just before and just 

after the collision, during a time of approximately constant velocity.  

2. Encourage students to use gentle collisions. The physics is the same, and the duration of the 
constant-velocity sections is longer so that a good pre- and post-collision velocity can be 
found.  

3. The collision will conserve momentum since there is no external horizontal force on the 
system. 

4. The system will gain kinetic energy; it comes from the stored elastic potential energy of the 
spring plunger.  

5.  Typical experimental data for a collision with the second cart initially at rest will look 
something like this: 
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Impulse and Momentum 
INTRODUCTION 
You are no doubt familiar with everyday uses of the term momentum; e.g., a sports team that has 
begun to exert superiority over an opponent is said to have gained “momentum.” However, in 
physics, this term has a precise definition: momentum, p, is the product of the mass and velocity 
of an object, . 

You have learned that a net force is required to change the velocity of an object. In this 
experiment you will examine how the momentum of a cart changes as a force acts on it. This will 
enable you to determine the relationship between force, the length of time the force is applied, and 
the change in the momentum of the cart. 

OBJECTIVES 
In this experiment, you will 

• Collect force, velocity, and time data as a cart experiences different types of collisions.  
• Determine an expression for the change in momentum, ∆p, in terms of the force and 

duration of a collision. 
 

MATERIALS 
Vernier data-collection interface Vernier Dynamics Track  
Logger Pro or LabQuest App Motion Encoder Cart  
Vernier Motion Encoder Reciever Vernier Bumper and Launcher Kit  
Vernier Dual-Range Force Sensor  

 
 
PRE-LAB QUESTIONS 
1. In a car collision, the driver’s body must change speed from a high value to zero. This is true 

whether or not an airbag is used, so why use an airbag? How does it reduce injuries? 

2. Suppose airbags were not vented to allow the gas inside to escape, but remained inflated (like 
a balloon). Would they be as effective in protecting a passenger in a collision? 
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PROCEDURE 
1. Attach the Motion Encoder Receiver to the end of the Dynamics Track, aligning the encoder 

strip on the track with the stripes on the Receiver. 

2. Adjust the leveling screws on the feet as needed to level the track. To make sure the track is 
level, give the cart a gentle push. It should reach the opposite end of the track without a 
noticeable change in velocity. 

3. Connect the Motion Encoder Reciever and the Dual-Range Force Sensor (DFS) to the 
interface and start the data-collection program. Increase the data-collection rate to 500 
samples/second1. The duration of the experiment can be reduced to 5 seconds.  

4. Make the necessary adjustments so that two graphs: force vs. time and velocity vs. time 
appear in the graph window. 

Part 1  Elastic collisions 
5. Replace the hook end of the force sensor with the hoop spring bumper.2 Attach the force 

sensor to the bumper launcher assembly as shown. Then attach the bumper launcher assembly 
to the end of the track opposite the motion detector. 

Figure 1 
 Note: Shown inverted for assembly. 

Figure 2 
 
6. Practice launching the cart with your finger so that when it collides with the hoop spring 

bumper, it slows to a stop and reverses direction smoothly. An abrupt collision will not yield 
satisfactory data. 

                                                
1 250 samples/second for LabPro 
2 If this type spring is not available, your instructor will show you how to use an alternate arrangement to collect 

the data for this experiment. 
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7. Position the cart near the Motion Encoder Receiver, turn on the Motion Encoder Transmitter 
in the cart, then zero both the Motion Encoder and the force sensor.  

8. Start data collection. After a brief moment, launch the cart toward the hoop spring bumper. 
Be sure to catch the cart once it has returned to its starting position. Because both force and 
velocity are vector quantities, check to see if the signs of force and velocity match your 
experimental setup. If necessary, reverse the direction of one or both sensors.  

 9. Collect data for at least three elastic collisions, varying the mass of the cart. Be sure to store 
the data for each run.  

Part 2  Inelastic collisions 
1. Replace the hoop spring bumper with one of the clay holders from the Bumper and Launcher 

Kit. Attach cone-shaped pieces of clay to both the clay holder and to the front of the cart, as 
shown in Figure 3. 

 
Figure 3 

2. Set the switch on the force sensor to the 50 N position; reset the data-collection parameters as 
you did in Step 4.  

3. Practice launching the cart with your finger so that when the clay “nose” on the front of the 
cart collides with the clay on the force sensor, the cart comes to a stop without bouncing. A 
collision that is too jarring will not yield satisfactory data. 

4. Position the cart near the Motion Encoder Receiver, then zero both the Motion Encoder and 
the force sensor. 

5. Collect data as before for at least three inelastic collisions, varying the mass of the cart. Be 
sure to store the data for each run. 

 
EVALUATION OF DATA  
Part 1  Elastic collisions 
1. On the velocity vs. time graph, select the interval corresponding to the period of time when 

the spring was acting on the cart. LabQuest App automatically selects the same interval on 
both graphs when you drag the stylus across an interval on one of the graphs. However, in 
Logger Pro, you first have to select both graphs and group them (x-axes). Next, turn on the 
Examine tool for each graph. Then, make the v-t graph the active window and drag the cursor 
across the appropriate interval.  

 In either program, when you choose Statistics from the Analyze menu, you will have the 
velocity of the cart just before and just after the collision with the spring. 
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2. From the mass of the cart and its change in velocity, if vv − , determine the change in 
momentum, ∆p, of the cart. 

3. As you learned in kinematics, the area under a curve often has physical significance. In the 
case of the F-t graph, the area of the interval you selected is the product of the average force 
and the time during which the spring was interacting with the cart. You can determine this 
area by choosing Integral from the Analyze menu. In your class discussion you will give a 
name to this quantity. 

4. Compare the value (both magnitude and sign) of the quantity you determined in Step 3 with 
the change in momentum of the cart. 

5. Perform similar analyses for your remaining elastic collisions. Determine the % difference 
between the impulse, tF∆ , and the change in momentum, ∆p, for each of the collisions. 
Compare your findings to those of others in your class. What can you conclude about these 
quantities? 

Part 2  Inelastic collisions 
1. As you did in Step 1 of Part 1, select the interval corresponding to the period of time from 

slightly before to slightly after the collision. Due to the shorter duration of this type of 
collision, you should zoom in on this portion of both graphs. Note any differences in the shape 
of the F-t graph for this type of collision. Try to account for this difference. 

2. Because some bouncing is unavoidable, you should discuss how to select an appropriate 
interval of the F-t graph for your determination of the impulse. Assume the final velocity of 
the cart is zero. 

3. As you did with the elastic collisions, determine the % difference between the impulse, tF∆ , 
and the change in momentum, ∆p, for each of the inelastic collisions. Compare your findings 
to those of others in your class. What can you conclude about these quantities? 

4. From Newton’s second law, derive the equation you have determined from the analysis of 
your data.  Compare the fundamental units for both impulse and change in momentum. 

 
EXTENSIONS 
1. When you catch a fast-moving baseball, it hurts less when your hand “gives” a little than if 

you hold your hand stiff. Explain why this is so in terms of impulse and change in momentum. 

2. Now cars are made to crumple during a collision. Explain how this works in terms of impulse 
and change in momentum. 

3. Suppose you had used a stiffer spring in the experiment. Describe how the shape of the  
force vs. time graph would differ from that which you observed. 
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Thin Lenses and Real Images 
INTRODUCTION 
In this investigation, you will explore the formation of real images by convex lenses. You will 
have the opportunity to project images in various configurations, and explore the variables that 
affect the appearance, size, and location of a real image. After exploring these phenomena, you 
will formalize your explanations and develop mathematical relationships describing the 
phenomena. 

 
OBJECTIVES 
In this experiment, you will 

• Use lenses to produce real images.  
• Explore how lens characteristics and the position of the object affect the appearance, 

orientation, and size of real images. 
• Determine the relationship between object distance, image distance, focal length and 

magnification in real images produced by convex lenses. 
 
 
MATERIALS 

Logger Pro or LabQuest App Vernier Optics Expansion Kit 
Vernier Dynamics System track  

 
 
PRE-LAB INVESTIGATION 
1. Place the viewing screen from the Optics 

Expansion Kit at the 10 cm mark on the Vernier 
track. Then place the 10 cm double convex lens 
somewhere around the middle of the track (see 
Figure 1).  

2. Aim the end of the track that is nearer to the lens 
at a window to the outdoors so that light from 
distant objects can pass through the lens and 
strike the screen. If no window is available, aim 
the track at a light bulb in a fixture at least five 
meters away. 

3. Move the lens until a clear image appears on the 
viewing screen. Describe the size, shape, and 
orientation of the image as well as the position of 
the lens when the image is sharp. Figure 1 
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4. Repeat this process, using the 20 cm double convex lens. Make note of the similarities and 
differences in the images produced by the two lenses. 

In your class discussion, you will learn how the use of ray diagrams can help you to determine 
how and where light from a particular point on an object converges to form an image. You can 
get a conceptual understanding of the process of image-formation by a lens using the “Geometric 
Optics” simulation available from the PhET web site.1 

 
PROCEDURE 
1. Set up the light source and lens to project a clear image on the screen. 

a. Attach the light source assembly from the Optics Expansion Kit to the Vernier track. 
Position it so that the pointer in the base is at the 10 cm mark and the light source faces the 
other end of the track.  

b. Place the 10 cm double convex lens on the track, at the 25 cm mark. 
c. Attach the screen to the track and position it so that light from the light source passes 

through the lens and strikes the screen.  
d. Turn the light source wheel until the number “4” is visible in the opening. This will be your 

“object” for this investigation. 
e. Adjust the position of the screen until the image of the “4” on the screen is in focus (see 

Figure 2). One approach to obtain the sharpest image, once you think you have it, is to 
move the screen until the image begins to blur, then move it back until it again appears 
sharp. 

 
Figure 2 

                                                
1 http://phet.colorado.edu/en/simulation/geometric-optics 
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2. Describe the size, shape, and orientation of the image. 

3. Record the distance between the light source and the lens as “object distance” and the distance 
between the lens and the screen as “image distance” in your lab notebook.  

4. Obtain object distance and image distance data for five more points over as wide a range as is 
practical. Note what happens to the size of the image as the object distance increases. 

5. Return the lens to the 25 cm mark on the track. Gradually move the lens closer to the light 
source. When it reaches the 20 cm mark, can you find a position for the screen where the 
image is in focus? 

6. Repeat Steps 1–4 using the 20 cm double convex lens with the exception that you should first 
position the lens at the 35 cm mark. For this lens position, you will need to hold the screen 
beyond the end of the track to obtain a sharp image. 

7. After you have obtained at least six data points, return the lens to the 35 cm mark, then 
gradually move the lens closer to the light source. Note the smallest object distance where you 
cannot obtain a focused image, no matter where the screen is placed. 

 
EVALUATION OF DATA  
1. Choose New from the File menu in the data-collection program. In the table, manually enter 

your data for your measurement with the 10 cm lens. Enter d-o (for object distance) and d-i 
(for image distance) as the Names of the columns. 

2. Examine your graph of image distance vs. object distance. What relationship appears to exist 
between these variables? Rather than performing a curve fit to the data, take steps to modify 
one of the variables so as to produce a linear graph.  

Using Logger Pro 
 Choose New Calculated Column from the Data menu. After entering a name and units for the 

column, click the equation field, enter the expression to modify the variable you choose from 
the drop-down menu, and then click Done. Change the variable on the axis you have chosen 
to modify to see the resulting graph. 

Using LabQuest App 
 Choose New Calculated Column from the Table menu. After choosing a name and units for 

the column, select A/X as the Equation Type. Enter the column you wish to modify, then 
select OK. Tap the Graph tab and change the variable on the axis you have chosen to modify 
to see the resulting graph. 

 You may find it necessary to modify the variables on both axes to linearize the graph. When 
you have done so, write the equation of the best-fit line. 

3. Examine the value and the units of the slope. Discuss with your instructor what the ideal value 
of the slope might be.  

4. Examine the value and units of the vertical intercept. In view of the modifications you made to 
the object distance and image distance in order to produce a linear graph, draw a conclusion 
about the physical significance of the intercept. 
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5. If you are using Logger Pro, add a New Data Set to your file and repeat Steps 1 and 2 with 
your measurements for the 20 cm convex lens. If you are using LabQuest App, start a new file 
to do this. 

6. Examine your slope and intercept as you did earlier. Are your findings consistent with those 
for the 10 cm lens? 

7. Write a general equation of your best-fit line in terms of di, do, and f; rearrange the equation 
so that di and do are on the same side. Compare your results to the thin-lens equation in your 
text or a web-based resource. 

8. The magnification, m, of an image is the ratio of the image height, i, to the object height, o. 
Using similar triangles, one can show that it is also equal to the ratio of the image distance to 
the object distance.  

 

m =
i
o

= −
di

do

 

 Note: the negative sign is included as part of the convention to indicate that the real image is 
inverted.  

 Using the 10 cm double convex lens, find a configuration of the lens and the screen that 
produces an image of the “4” used as the object that measures 4 mm across. Measure di and 
do and compare the agreement between the two ratios. Repeat this process for an image that is 
twice as large. The “4” on the light source is 20 mm across. 

 
EXTENSIONS 
1. Suppose you had used a 15 cm double convex lens in your experiment. Predict the slope and 

the intercept for the graph of 1/di vs. 1/do.  

2. When you sketched ray diagrams to show the location and size of a real image, you most 
likely used the principal rays. Suppose half of the lens were covered by a piece of dark paper 
so that two of these rays (parallel to the optical axis and passing through the center of the 
lens) were blocked. Could an image form under these circumstances? Try it with your 
apparatus; record your findings. Re-visit the PhET simulation “Geometric Optics” and choose 
the Many Rays option to help you understand your results. 
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Curved Mirrors and Images 
INTRODUCTION 
While we all feel familiar with the images we see in plane mirrors, our experiences with their 
curved counterparts might be limited to cosmetic mirrors or the side view mirrors on automobiles. 
In this experiment, you will explore the characteristics of the real and virtual images formed by 
curved mirrors. Then you will develop a mathematical relationship describing the relationship 
between the positions of the object and the real image formed by concave mirrors. 

 
OBJECTIVES 
In this experiment, you will 

• Use curved mirrors to produce real and virtual images.  
• Explore how the position of the object affects the appearance, orientation, and size of real 

images produced by concave mirrors. 
• Explore how mirror characteristics and the position of the object affect the appearance, 

orientation, and size of virtual images produced by concave and convex mirrors. 
• Determine the relationship between object distance, image distance, focal length, and 

magnification in real images produced by concave mirrors. 
 
 
MATERIALS 

Logger Pro or LabQuest App Vernier Mirror Set 
Vernier Dynamics System track small plane mirror 
Vernier Optics Expansion Kit  

 
 
PRE-LAB INVESTIGATION 
1. Place the convex mirror at one end of the track. Position your eye at the other end of the track 

and examine the image of yourself. In what way does the image of yourself differ from that 
which you would see if you were looking into a plane mirror? How does the image change 
when you move the mirror closer to you? 

2. Replace the convex mirror with the concave one and move it to the end of the track. As you 
did before, position your eye at the other end of the track and examine the image of yourself. 
In what ways does the image of yourself differ from that which you observed with the convex 
mirror? What happens to the image when you move your head slightly from side to side?  

3. Gradually move the concave mirror closer to you. How does this affect the image you 
observe? What happens to the image when the mirror is approximately 20 cm from your eye? 

In your class discussion, you will learn how the use of ray diagrams can help you to determine 
how and where light from a particular point on an object converges to form an image. You can 
get a conceptual understanding of the process of image-formation by a curved mirror using the 
simulation available at the Davidson University web site.1 

                                                
1 webphysics.davidson.edu/course_material/py230L/optics/lenses.htm 
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PROCEDURE 
Part 1  Concave mirror and real images 
1. Set up the light source and concave mirror to project a clear image on the half screen. 

a. Attach the light source assembly from 
the Optics Expansion Kit to the Vernier 
track. Position it so that the pointer in 
the base is at the 10 cm mark and the 
light source faces the other end of the 
track.  

b. Place the concave mirror near the other 
end of the track so that it faces the light 
source. Attach the half screen to the 
track between the light source and the 
mirror.  

c. Turn the light source wheel until the 
number “4” is visible in the opening. 
This will be your “object” for this 
investigation. 

d. Adjust the position of the screen until 
the image of the “4” on the screen is in 
focus (see Figure 1). You may need to 
adjust the angle of the mirror in its 
holder so that the image projected by 
the mirror shows on the screen. One 
approach to obtain the sharpest image, 
once you think you have it, is to move 
the screen in either direction until the image begins to blur, then move it back until it again 
appears sharp.  

 
2. Describe the size, shape, and orientation of the image. 

3. Now, move the mirror to the 100 cm mark, then move the screen toward the mirror until you 
can see a sharp image of the “4” on the half screen. Record the distance between the light 
source and the mirror as “object distance” and the distance between the mirror and the screen 
as “image distance” in your lab notebook.  

4. Obtain object distance and image distance data for four more points, moving the mirror 10 cm 
closer each time. Note what happens to the size of the image as the object distance decreases. 

5. Move the mirror to the 50 cm mark, leaving the light source at 10 cm. Note that you cannot 
obtain a sharp image on the screen. If you remove the screen and rotate the mirror slightly, 
you can observe a sharp image of the “4” on the light source assembly itself. Compare the size 
of the image to that of the object. 

6. It is possible to obtain another data point for which the mirror is even closer to the light 
source. To do so, move the light source to the middle of the track and the mirror 30 cm away. 
Hold the screen off to the side behind the light source and rotate the mirror until you can 
observe the projected image on the screen. Make your best estimate of the image distance. 

Figure 1 
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Part 2  Convex mirror and virtual images 

Locating a virtual image is more difficult because it 
cannot be projected onto a screen, like a real image. 
The technique described below involves the use of 
parallax to determine the position of the virtual image. 

1. Draw a vertical line on a 3″ × 5″ index card; place 
this card in the slot on the full viewing screen. This 
screen is your image position marker. Place the 
half screen (which serves as the object), convex 
mirror, and full screen on the track as shown in 
Figure 2. 

2. Move the convex mirror to a position 40 to 50 cm 
from the half screen. Record this as the object 
distance. Stand at the end of the track near the half 
screen so that you can view both the virtual image 
of the half screen and the index card attached to 
the full screen. 

3. Place the index card and screen serving as the 
position marker just behind the convex mirror. Position your head directly behind and above 
the half screen. As you look over the top of the half screen toward the mirror, you can view 
the half screen in the mirror. Move your head so that the line on marker and the edge of the 
half screen are aligned. 

4. Move your head to the right of the half screen. 
Note that the edge of the screen in the image 
appears to the right of the line on the marker. 
When you move your head to the left of the half 
screen you should note that the edge in the image 
shifts to the left of the marker line. (See Figure 
3.) This difference in relative positions is called 
parallax. 

5. Move the marker 5 cm farther from the mirror. 
When you repeat Step 4, the parallax is reduced. 
Gradually move the marker farther from the 
mirror and check the alignment of the edge of the 
half screen and the line on the marker until there 
is no parallax. Record this distance as the 
distance of the virtual image. If you go beyond 
the no-parallax point, the image and the object 
will move in opposite directions. 

 
EVALUATION OF DATA  
1. Choose New from the File menu in the data-collection program. In the table, manually enter 

your data for your measurement with the concave mirror. Enter d-o (for object distance) and 
d-i (for image distance) as the Names of the columns. 

Figure 2 

Figure 3 
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2. Examine your graph of image distance vs. object distance. What relationship appears to exist 
between these variables? Rather than performing a curve fit to the data, take steps to modify 
one of the variables so as to produce a linear graph.  
Using Logger Pro 

 Choose New Calculated Column from the Data menu. After entering a name and units for the 
column, click the equation field, enter the expression to modify the variable you choose from 
the drop-down menu, then click Done. Change the variable on the axis you have chosen to 
modify to see the resulting graph. 

Using LabQuest App 
 Choose New Calculated Column from the Table menu. After choosing a name and units for 

the column, select A/X as the Equation Type. Enter the column you wish to modify, then 
select OK. Tap the Graph tab and change the variable on the axis you have chosen to modify 
to see the resulting graph. 

 You may find it necessary to modify the variables on both axes to linearize the graph. When 
you have done so, write the equation of the best-fit line. 

3. Examine the value and the units of the slope. Discuss with your instructor what the ideal value 
of the slope might be.  

4. Examine the value and units of the vertical intercept. In view of the modifications you made to 
the object distance and image distance in order to produce a linear graph, draw a conclusion 
about the physical significance of the intercept. 

5. Write a general equation of your best-fit line in terms of di, do and f; rearrange the equation so 
that di and do are on the same side. Compare your results to the spherical mirror equation in 
your text or a web-based resource. 

6. The magnification, m, of an image is the ratio of the image height, i, to the object height, o. 
Using similar triangles, one can show that it is also equal to the ratio of the image distance to 
the object distance.  

o

i

d
d

o
im −==  

 Note: the negative sign is included as part of the convention to indicate that the real image is 
inverted.  

 Find a configuration of the mirror and the screen that produces an image of the “4” used as 
the object that measures 10 mm across. Measure di and do and compare the agreement 
between the two ratios. Repeat this process for an image that is half as large. The “4” on the 
light source is 20 mm across. 

7. In the sign convention used for spherical mirrors, both the focal length of a convex mirror and 
the image distance for a virtual image have negative values. The focal length of the convex 
mirror in the mirror set is –20 cm. Use the spherical mirror equation to calculate the expected 
distance for the virtual image. How does this compare to the value you obtained from your 
observations? 
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EXTENSIONS 
1. Suppose you had used a 15 cm concave mirror in your experiment. Predict the slope and 

intercept of the graph of 1/di vs. 1/do. 

2. In what ways are the virtual images one can see with both convex and concave mirrors the 
same? How are they different? 

3. Determine the virtual image distance for at least five more positions of the half screen serving 
as the object as you did in Part 2. Create a new Data Set in your Logger Pro or LabQuest 
App file and enter the values for the object and image distances. Insert a new graph and 
choose 1/di as the vertical axis label and 1/do as the horizontal axis label. Apply a linear fit as 
before and determine the agreement between your data and the spherical mirror equation. 
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Centripetal Acceleration 
INTRODUCTION 
The typical response when one hears the word acceleration is to think of an object changing its 
speed. You have also learned that velocity has both magnitude and direction. So, an object 
traveling at constant speed in a circular path is undergoing an acceleration. In this experiment you 
will develop an expression for this type of acceleration.  

 
OBJECTIVES 
In this experiment, you will 

• Analyze velocity vectors of an object undergoing uniform circular motion to determine the 
direction of the acceleration vector at any given moment. 

• Collect force, velocity, and radius data for a mass undergoing uniform circular motion.  
• Analyze the force vs. velocity, force vs. mass, and force vs. radius graphs. 
• Determine the relationship between force, mass, velocity, and radius for an object 

undergoing uniform circular motion. 
• Use this relationship and Newton’s second law to determine an expression for centripetal 

acceleration. 
 
 
MATERIALS 

Vernier data-collection interface Vernier Centripetal Force Apparatus 
Logger Pro masses 
Vernier Photogate  
Dual-Range Force Sensor  

 
 
PRE-LAB INVESTIGATION 
Tie something soft (such as a stopper) to a one-meter length of string. Taking care not to hit 
anyone nearby, swing the stopper so that it travels in a horizontal circular path over your head. 
Feel the tension force you must apply in order to keep the stopper moving at a nearly constant 
speed. Now, see what effect varying the speed of the stopper or the length of the string has on the 
force you apply to keep the stopper moving in a circular path. Record your observations. 

Your instructor will lead a discussion that will enable you to determine the direction of the 
acceleration vector for an object moving at constant speed in a circular path. For this experiment, 
you will use an apparatus that will allow you to measure the force acting on an object undergoing 
circular motion that is more uniform than you could achieve by swinging it. 
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PART 1 – FORCE VS. VELOCITY  
PROCEDURE 
1. Attach a Dual-Range Force Sensor and a Vernier Photogate to the Vernier Centripetal Force 

Apparatus (CFA), as shown in Figure 1.  

 
Figure 1 

2. Connect the force sensor and the photogate to the interface. 

3. Set up data collection. 
a. Open the experiment file 12A Centripetal Acceleration.cmbl. Data collection has been 

set up so that Logger Pro calculates the distance the carriage on the beam has 
travelled during its circular motion. You can examine the formula by double-clicking 
on the column header for Distance.  

b. Because Distance column calculation depends on the radius of the circular path, you 
must change the value of the radius parameter in Logger Pro whenever you move the 
carriage. 

c. Press the spacebar to stop collecting data when you think it is appropriate to do so. 
 
4. Determine the mass of the sliding mass carriage. Add mass to both the sliding and fixed mass 

carriages as directed by your instructor. The mass of the sliding and fixed carriages should be 
the same so that the beam is balanced. Record the total mass of the sliding carriage and extra 
mass. 

5. Position the fixed carriage so that its center is 10 cm from the axis of rotation. Adjust the 
position of the force sensor on the rail so that, when the line is taut, the center of the sliding 
mass carriage is also at 10 cm. Make sure that the parameter, radius, in Logger Pro is set to 
0.10 m. 
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6. Zero the force sensor.  

7. Spin the beam by twisting the knurled spindle of the CFA with your fingers. When the force 
reaches 5–8 N, begin collecting data. When you stop data-collection, use the friction between 
your hand and the knurled spindle to stop the beam.  

 
EVALUATION OF DATA  
1. Choose Next Page from the Page menu. Note that the vertical axis displays  

Force-interpolated; these are values that Logger Pro has interpolated from the values of force 
measured by the sensor. 

2. Write a statement that describes the relationship between the force acting on the carriage and 
its tangential velocity. 

3. If your graph of force vs. velocity is not linear, take steps to modify a column so as to obtain a 
linear relationship. Choose New Graph from the Insert menu, choose the new column variable 
for the horizontal axes, and then rearrange the graphs on the page.  

4. Write the equation of the line that best fits your linearized graph. Simplify the units of your 
slope as much as possible. Save your Logger Pro file.  

5. Compare the value of the slope of the linearized graph with that obtained by other groups in 
your class. Speculate about what might be responsible for any differences in the slopes.  

 
PART 2 – INVESTIGATING THE EFFECT OF MASS AND RADIUS 
When a quantity (in this case, force) is a function of more than one variable, it is usually the case 
that the slope of the graph is related to the parameters held constant during the experiment. 
Examine the units of the slope of your graph of F vs. v2. Write an expression involving mass and 
radius that has the same units as that of your slope. Substitute the known values of these 
parameters; how closely does the value of this expression agree with that of your slope? Predict 
the effect of doubling the mass on the value of the slope. What effect would doubling the radius 
have on the slope? You can test your conclusions by varying first the mass and then the radius as 
follows. 

PROCEDURE 
1. Store your first run.  

2. Change the mass on both the fixed and sliding carriages and record the value of the total mass 
of the sliding carriage and any extra masses. Return to Page 1 of your experiment file. 

3. Re-zero the force sensor, then spin the beam as you did before. Once the force reaches  
5–8 N, begin collecting data. When you stop data collection, stop the beam as you did in 
Part 1. Store this run.  

4. Change the system mass again and record the value of the total mass of the sliding carriage 
and any extra masses, then repeat Step 3. 

5. Return the mass on both the fixed and sliding carriages to the original value used in  
Part 1.  
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6. Decrease the radius of both the sliding and fixed mass carriages  by 2–3 cm. Record the value 
of the radius. 

7. Re-zero the force sensor, then spin the beam as you did before. Once the force reaches  
5–8 N, begin collecting data. When you stop data collection, stop the beam. Store this run. 

8. Now, change the radius so that it is 2–3 cm greater than your initial value. Record the value of 
the radius, then repeat Step 7. 

 
EVALUATION OF DATA  
1. Return to Page 2 of your Logger Pro file. 

2. Select More on the vertical axis on the Force-interpolated vs. velocity graph and select the 
interpolated force for the three runs in which mass was varied. On the graph you should see a 
family of curves. 

3. Now do the same for the Force-interpolated vs. velocity2 (F-i vs. v2) graph. Perform linear fits 
on all three sets of data. Record the value of the slope of each of the equations of the lines. 
What relationship appears to exist between the value of the slope and the total mass of the 
sliding carriage? 

4. To study the effect of changing the radius, select More on the vertical axis of the F-i vs. v2 
graph. De-select Force-interpolated for the runs you examined in Step 3. Now, select it for 
one of the runs in which you changed the radius. 

5. Because the velocity was calculated using the value of the radius, you must set this parameter 
to the radius used for each run you wish to examine. Perform a linear fit on the data for the 
desired run. Compare the value of the slope for this run to that for your first run (r = 0.10 m). 

6. Repeat Steps 4 and 5 for another run in which you changed the radius. Does the change in the 
radius have the expected effect on the value of the slope? Compare your findings with those of 
other groups in class. 

7. Write an equation relating the net force, mass, radius and velocity of a system undergoing 
circular motion. 

8. Use what you have learned in Steps 3–5 of this section and Newton’s second law to write an 
equation for the acceleration of the object undergoing circular motion. Use your text or a web 
resource to determine the meaning of the term “centripetal.” 

 
EXTENSION 
Wikipedia warns that the centripetal force is not to be confused with centrifugal force. It describes 
the latter as a fictitious or inertial force. Describe an example of such a force that you have 
experienced and how this interaction might better be explained in terms of centripetal force.  
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Conservation of  
Angular Momentum 

INTRODUCTION 
In your study of linear momentum, you learned that, in the absence of an unbalanced external 
force, the momentum of a system remains constant. In this experiment, you will examine how the 
angular momentum of a rotating system responds to changes in the moment of inertia, I. 

OBJECTIVES 
In this experiment, you will 

• Collect angle vs. time and angular velocity vs. time data for rotating systems. 
• Analyze the θ-t and ω-t graphs both before and after changes in the moment of inertia. 
• Determine the effect of changes in the moment of inertia on the angular momentum of the 

system.  
 

MATERIALS 
Vernier data-collection interface ring stand or vertical support rod 
Logger Pro or LabQuest App balance 
Vernier Rotary Motion Sensor metric ruler 
Vernier Rotary Motion Accessory Kit  

 
 
PROCEDURE 
1. Mount the Rotary Motion Sensor to the vertical support rod. Place the 3-step Pulley on the 

rotating shaft of the sensor so that the largest pulley is on top. Measure the mass and diameter 
of the aluminum disk with the smaller hole. Mount this disk to the pulley using the longer 
machine screw sleeve (see Figure 1). 

 
Figure 1 
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2. Connect the sensor to the data-collection interface and begin the 
data-collection program. The default data-collections settings are 
appropriate for this experiment.  

3. Spin the aluminum disk so that it is rotating reasonably rapidly, then 
begin data collection. Note that the angular velocity gradually 
decreases during the interval in which you collected data. Consider 
why this occurs. Store this run (Run 1). 

4. Obtain the second aluminum disk from the accessory kit; determine 
its mass and diameter. Position this disk (cork pads down) over the 
sleeve of the screw holding the first disk to the pulley. Practice 
dropping the second disk onto the first so as to minimize any torque 
you might apply to the system (see Figure 2). 

5. Begin the first disk rotating rapidly as before and begin collecting 
data. After a few seconds, drop the second disk onto the rotating 
disk and observe the change in both the θ-t and ω-t graphs. Store 
this run (Run 2). 

6. Repeat Step 5, but begin with a lower angular velocity than before. 
Store this run (Run 3). 

7. Find the mass of the steel disk. Measure the diameter of both the 
central hole and the entire disk. Replace the first aluminum disk with 
the steel disk and hub and tighten the screw as before (see Figure 3). 

8. Try to spin the steel disk about as rapidly as you did the aluminum 
disk in Step 3 and then begin collecting data. Store this run (Run 4).  

9. Repeat Step 5, dropping the aluminum disk onto the steel disk after 
a few seconds. Store this run (Run 5) and save the experiment file in 
case you need to return to it. 

 
EVALUATION OF DATA  
1. Use a text or web resource to find an expression for the moment of inertia for a disk; 

determine the values of I for your aluminum disks. With its large central hole, the steel disk 
should be treated as a cylindrical tube. Using the appropriate expression, determine the value 
of I for the steel disk.  

2. Examine the ω-t graph for your runs with the single aluminum disk (Run1) and the steel disk 
(Run 4). Determine the rate of change of the angular velocity, ω, for each disk as it slowed. 
Account for this change in terms of any unbalanced forces that may be acting on the system. 
Explain the difference in the rates of change of ω (aluminum vs. steel) in terms of the values 
you calculated in Step 1. 

Figure 2 

Figure 3 
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3. Examine the ω-t graph for Run 2. Determine the rate of change of ω before you dropped the 
second disk onto the first. Record the angular velocity just before and just after you increased 
the mass of the system. Determine the time interval (∆t) between these two velocity readings. 

• In Logger Pro, drag-select the interval between these two readings. The ∆x in the lower 
left corner gives the value of ∆t. 

• In LabQuest App, drag and select the interval between these two readings and use the 
Delta function under Statistics to perform this task. 

4. The angular momentum, L, of a system undergoing rotation is the product of its moment of 
inertia, I, and the angular velocity, ω. 

 

L = Iω  
 Determine the angular momentum of the system before and after you dropped the second 

aluminum disk onto the first. Calculate the percent difference between these values. 

5. Use the initial rate of change in ω and the time interval between your two readings to 
determine ∆ω due to friction alone. What portion of the difference in the angular momentum 
before and after you increased the mass can be accounted for by frictional losses?  

6.  Repeat the calculations in Steps 3–5 for your third and fifth runs. 

 
EXTENSION 
In this experiment, the moment of inertia of the rotating system was changed by adding mass. In 
what other way could one change the moment of inertia? Consider an example of how this is done 
outside the lab. Explain how this change in I produces a change in ω . 
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Spectrum of Atomic Hydrogen 
INTRODUCTION 
You have no doubt been exposed many times to the Bohr model of the atom. You may have even 
learned of the connection between this model and bright line spectra emitted by excited gases. In 
this experiment, you will take a closer look at the relationship between the observed wavelengths 
in the hydrogen spectrum and the energies involved when electrons undergo transitions between 
energy levels. 

 
OBJECTIVES 
In this experiment, you will 

• Use a spectrometer to determine the wavelengths of the emission lines in the visible 
spectrum of excited hydrogen gas. 

• Determine the energies of the photons corresponding to each of these wavelengths. 
• Use a modified version of Balmer’s equation to relate the photons’ energies to specific 

transitions between energy levels. 
• Use your data and the values for the electron transitions to determine a value for 

Rydberg’s constant for hydrogen. 
 
 
MATERIALS 

Vernier LabQuest with LabQuest App or VIS-NIR Optical Fiber 
   computer with Logger Pro straight-line filament incandescent  
Red Tide Emissions Spectrometer     bulb and socket 
Vernier Spectrum Power Supply and  replica diffraction grating 
   Hydrogen Tube or   
   conventional hydrogen gas discharge tube  

 
 
PRE-LAB INVESTIGATION 
1. Place the incandescent bulb in the socket, plug it in, and turn on the electrical power to the 

bulb. View the spectrum through the diffraction grating. 

2. Place the hydrogen discharge tube in the power supply socket. Turn on the power and observe 
the bright line spectrum of hydrogen through the diffraction grating. 

Discuss the differences in the spectra from these two sources. The appearance of bright line 
spectra for excited gases created a seemingly insoluble problem for physicists in the late 19th 
century. They could not find a simple way to explain why only certain wavelengths were emitted 
by excited gases. In 1885, Johann Balmer, a Swiss high school mathematics teacher, found an 
empirical equation 

 

λ = 364.56 nm
m2

m2 − 22
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where m was an integer greater than 2, that related the wavelengths of the lines in the visible 
spectrum of hydrogen. Three years later, Johannes Rydberg, a master of spectroscopy, rearranged 
Balmer’s equation and expressed it in a more general form 

 

1
λ

= RH
1
n1

2 −
1
n2

2

 

 
 

 

 
  

where 1/λ is the wavenumber (the reciprocal of the wavelength expressed in m), RH is Rydberg’s 
constant and n1 and n2 are integers such that n1 < n2. This equation led to the discovery of similar 
sets of spectral lines in the ultraviolet (Lyman series) and infrared (Paschen series) in the early part 
of the 20th century. 

Nevertheless, it was not until Niels Bohr proposed his model of 
the hydrogen atom in 1911 that a causal explanation for the 
existence of the bright line spectra emerged. Bohr assumed that 
the electron circled the nucleus in certain well-defined orbits 
corresponding to specific energy states (see Figure 1 at right). In 
his model of the hydrogen atom, the electron can exist only in one 
of these energy states. Ordinarily, the electron exists in its lowest 
energy condition (called the ground state). So long as the electron 
is in a particular energy state, the atom does not emit light energy. 
However, when a hydrogen atom is given enough energy (via an 
inelastic collision or photon absorption), the electron is bumped 
up from its ground state (n = 1) to an excited state (n > 1). When 
the electron drops back to a lower energy state, a photon is 
usually emitted. The lines in the hydrogen spectrum represent various 
transitions made by electrons from higher to lower energy states. 

Further detail on the connection between the Bohr model and bright line spectra can by found by 
observing approximately 5 minutes of a video clip from Episode 3 of Brian Greene’s Fabric of the 
Cosmos,1 which can be viewed from the PBS NOVA web site. 

In this experiment you will analyze the visible bright line spectrum for hydrogen and use a 
variation of the Rydberg equation to relate the energy of the photons associated with each bright 
line to the energy levels in the Bohr model of the atom. 

 
PROCEDURE 
1. If you are using Logger Pro, connect the spectrometer to a USB port on the computer and 

choose New from the File menu. Connect the appropriate optical fiber cable to your 
spectrometer. If you are using LabQuest as a standalone device, connect the spectrometer to 
the USB port on LabQuest and choose New from the File menu.  

                                                
1 http://www.pbs.org/wgbh/nova/physics/fabric-of-cosmos.html#fabric-quantum. The relevant section starts at time 

index 6:38 minutes. 

Figure 1 
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2. Set up the data-collection parameters. 
Using Logger Pro  
a. Choose Change Units ►Spectrometer ►Intensity from the Experiment menu. The 

software will measure the intensity in relative units.  
b. Next, choose Set Up Sensors ►Spectrometer from the Experiment menu. Change the 

data-collection duration to 40 ms. 
Using LabQuest App 
a. On the Meter screen, choose Change Units ► Intensity from the Sensors menu. The 

software will measure the intensity in relative units.  
b. Change the data-collection duration to 40 ms. 

 
3. Turn on the power to the hydrogen spectrum tube and aim the end of the optical fiber at the 

middle of the spectrum tube. Your equipment may have a bracket that will hold the end of the 
optical fiber in position. Note: Hydrogen tubes have a limited lifetime, so do not leave the 
tube on when you are not taking data. 

4. Start data collection. If the peak for the red line (H-α) of the spectrum saturates (flat, wide 
peak at an intensity value of 1.0), move the tip of the optical fiber slightly farther away. If this 
peak is too small, shift the position of the tip so that more light from the discharge tube enters 
it. When the intensity of this peak reaches a value of at least 0.8, stop data collection. You 
need to see at least four distinct peaks to perform this analysis. Depending on your hydrogen 
tube, you may need to collect two runs: one with no peak height above 0.9, and another with 
the two strongest peaks saturated at 1.0 so that you can detect the smaller peaks.  

5. Once you have at least four peaks visible, save your experiment file. Turn off the hydrogen 
discharge tube.  

 
EVALUATION OF DATA  
1. Use the Examine tool to find the maximum intensity for the red line you observed in the  

H-spectrum. Record the wavelength. Repeat this step for the remaining peaks. 

2. Use the value for the speed of light to calculate the frequency of each of these bright lines. 
Keep in mind that your wavelengths were measured in nm. 

3. Using Planck's equation E = hf, calculate the energy of the light emitted for each of the 
observed lines. Planck’s constant is sJ1063.6 34 ⋅×= −h . Record your values in a table like the 
one below: 

Color Wavelength 
(nm) 

Frequency 
(1/s) 

Δ Energy 
(J) 

red    
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4. The photon energies you calculated in Step 3 result from differences in the allowed energy 
states of the electron in hydrogen atoms, ∆E = Efinal – Einitial. While they provide a clue to the 
allowed energy states, these values alone are insufficient to determine the actual energy of the 
allowed energy states. We can, however, make use of the fact that ∆E = hf = hc/λ to obtain a 
form of the Rydberg equation that relates the energy of the emitted light to the initial and final 
energy states. 











−×=∆ −

22
18 11 J1018.2

if nn
E  

5. Your task is to determine values of nf and ni that that will give light energies that approximate 
the values that you calculated in Step 3.One way to approach this task is to divide your 
calculated values of ∆E by the constant, 2.18 × 10-18 J, then match this fraction by substituting 
various  

pairs of integers in the 

 

1
n f

2 −
1
ni

2

 

 
  

 

 
   portion of the equation. For example if nf = 1, and ni =2, 

then the expression 

 

1
n f

2 −
1
ni

2

 

 
  

 

 
  =

1
12 −

1
22

 
 
 

 
 
 = 0.75. 

 Record your values and best guesses for nf and ni in a table like the one below. Hint: nf and ni 
for these lines are both less than 8. 

Color ∆E 
(J) 

Ratio 
∆E/constant 

reasonable 
values for 
nf and ni 

red    

    

    

    

    
 
6. Compare your values for nf and ni to those obtained by others in your class. Reach a 

consensus about the values of nf and ni for each of the transitions. 

7. Determine ∆E for a number of transitions from higher energy levels to the ground state. 
Determine the wavelengths of the lines associated with each of these transitions. In what 
region of the electromagnetic spectrum would you expect to find them? Repeat this analysis 
for nf  = 3. 

8. Using the wavelengths you obtained in your analysis of the hydrogen spectrum and the values 
of nf and ni corresponding to the transitions producing these lines, determine an average value 
for the Rydberg constant for hydrogen. The Rydberg equation is in the Pre-Lab Investigation. 
How does your experimental value compare to the accepted value for this constant? 
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EXTENSION 
Visit the Visual Quantum Mechanics web site, http://phys.educ.ksu.edu/vqm/free/h2spec.html, 
and run the simulation for hydrogen spectroscopy. Note that a hydrogen gas discharge tube is lit 
and a spectrum appears at the top. Step-by-step directions are provided. See how closely your 
simulation spectrum matches the observed spectrum for hydrogen. 
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RLC Circuits 
INTRODUCTION 
You have studied the behavior of capacitors and inductors in simple direct-current (DC) circuits. 
In alternating current (AC) circuits, these elements act somewhat like resistors to limit current 
flow. The term used for the resistance these elements offer to current flow in AC circuits is 
reactance. The general term for the sum of all the resistance and reactance (both capacitive and 
inductive) in a circuit is impedance.  

The reactance for a particular capacitor or inductor varies with the frequency of the circuit. 
Capacitors store energy in electric fields. When fully charged, they will not let current flow in a 
DC circuit. However, in AC circuits, as the frequency increases, their resistance to the flow of 
charge decreases. Inductors store energy in magnetic fields. In DC circuits, an ideal inductor has 
no resistance, but in AC circuits, its resistance increases with the frequency. 

In this experiment, you will examine the behavior of an AC circuit containing a capacitor (C), an 
AC circuit containing a resistor and an inductor (RL), and an AC circuit containing all three 
elements (RLC). 

 
OBJECTIVES 
In this experiment, you will 

• Learn the terms capacitive reactance, inductive reactance, and impedance.  
• Determine the relationship between the reactance and frequency for a capacitor.  
• Determine the relationship between the impedance and frequency of an RL circuit. 
• Determine the resonant frequency of an RLC circuit. 
• Experiment with resonance and energy transfer in an RLC circuit. 

 
 
MATERIALS 

Vernier LabQuest or  powdered iron core1 
   LabPro or LabQuest Mini and a computer Vernier Inductor (5 mH) 
   with audio output and Vernier Power Vernier Circuit Board or  
   Amplifier computer program2    mini lamp (2.0V, #48, cylindrical)  
Logger Pro or LabQuest App    mini lamp holder 
Vernier Power Amplifier    clip leads 
Vernier Differential Voltage Probe    10 Ω resistor 
Vernier Current Probe    10 µF capacitor (non polarized) 

 
 

                                                
1 You could also use a number of painted nails taped together in place of this core. 
2 The Vernier Power Amplifier computer program can be downloaded from www.vernier.com/downloads. 
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PRE-LAB INVESTIGATION 
Consider the circuit in Figure 1.  

  
Figure 1 

What would the Current Probe read soon after you connected the leads to the battery? Why? 
Suppose you were able to connect the leads to the battery momentarily, disconnect them, then flip 
the battery, reconnect the leads, and repeat the process a number of times. What effect would this 
have on the current in the circuit? Why? 

If the capacitor were replaced by an inductor and the leads were connected to the battery, how 
would the current vary over time? Why? Suppose that you repeated the same battery flip process 
described above. What effect would this have on the current in the circuit? Why? 

In your class discussion, make sure you can explain the difference in the behavior of the circuits 
when the direction of the flow of charge is unchanged and when it changes rapidly. 

 
PART 1  A CAPACITOR IN A CIRCUIT 
PROCEDURE 
1. Set up the circuit with a 10 µF capacitor in series with a current probe, as shown in Figures 2 

and 3. The Voltage Probe will measure the potential difference across the capacitor plates. 

 
   Figure 2       Figure 3 
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2. Choose one of the following options to drive the Power Amplifier. 
LabQuest with Logger Pro 
a. Use the mini stereo cable that came with the amplifier to connect the Speaker Out port on 

LabQuest and the Audio In port on the amplifier. 
b. In Logger Pro, choose Set Up Sensors ► Show All Interfaces from the Experiment menu.  
c. From the Sensor Setup dialog box, click Power Amplifier. In the Waveform list, click Sine. 
d. The default value of 2.0 V is suitable, but change the initial frequency to 100 Hz. Use the 

up and down arrows to adjust the frequency, or use the parameter box to enter the desired 
value. 

e. Click Start. 
 

LabQuest as a standalone device 
a. Use the mini stereo cable that came with the amplifier to connect the Speaker Out port on 

LabQuest and the Audio In port on the amplifier. 
b. Launch Power Amplifier from the Home screen. The default setting of 2.0 VAC is suitable, 

but reduce the frequency to 100 Hz.  
c. Tap Start. Use the up and down arrows to adjust the frequency or enter the value in the 

parameter field. 
 

Power Amplifier computer program and the computer’s audio output 
Use this option if using LabQuest Mini or LabPro for data collection. 
a. Use the mini stereo cable that came with the Power Amplifier to connect the Speaker Out 

port on your computer and the Audio In port on the amplifier. 
b. Set the computer’s sound output on and at maximum volume.  
c. Start the Vernier Power Amplifier computer program. 
d. The default value of 2.0 V is suitable, but set the initial frequency to 100 Hz. To adjust the 

frequency, use the up and down arrows, or use in the parameter box to enter the desired 
value. 

e. Click Start. 
 
3. Connect the voltage and current probes to the interface and start the data-collection program. 

Two graphs, potential vs. time and current vs. time, will be displayed. Change the data-
collection rate to 10,000 samples/second and the duration to 0.02 seconds. 

4. Start the power amplifier output using a sine wave output with the frequency set to 100 Hz 
and an amplitude of 2.0 volts. Close the switch to complete the circuit. 

5. From your Pre-Lab Investigation, consider how the circuit you have constructed should 
behave. Now that you have connected this circuit to an AC voltage source, would you expect 
the current to be greater at low or high frequencies? 

6. To test your prediction, start data collection. When data collection stops, choose Statistics 
from the Analyze menu to determine the maximum value of the potential and the current for 
the run; record these values in your notebook. 

7. Continue collecting data in this way until you have potential and current values for  
6–7 frequencies ranging up to 1000 Hz.  
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EVALUATION OF DATA 
1. For each of your runs, the maximum voltage should have remained roughly the same. How 

did the maximum current in the circuit vary with frequency? Write a statement that describes 
the relationship you found. 

2. For each frequency, determine the capacitive reactance (Xc) of the capacitor by dividing the 
maximum value of the potential by the maximum value of the current. From what you know 
about Ohm’s law, determine the units of capacitive reactance. 

3. Disconnect the probes from the interface and choose New from the File menu. In the table, 
manually enter values so as to produce a graph of capacitive reactance vs. frequency. Instead 
of Hz, use 1/s as the units for frequency. Write a statement that describes the relationship 
between the capacitive reactance and frequency. 

4. If your graph of capacitive reactance vs. frequency is not linear, take steps to modify a column 
so as to produce a linear relationship. When you have done so, save your file and (if possible) 
print a copy of your original and then linearized graph.  

5. Write the equation of the line that best fits your linearized graph. Examine the units of the 
slope of the line.  

6. The textbook definition of capacitive reactance is 

 Rearrange this equation so that it has the same form as the one you recorded in Step 5. 
Compare the slope (value and units) of the equation for your linearized graph to the constant 
of proportionality in this equation. From the units for f and C, show that the unit of capacitive 
reactance is the ohm. 

7. Many capacitors have a tolerance of 10%. This means that their capacitance is only 
guaranteed to be within 10% of their labeled value. Would your data indicate that your 
capacitor is within its specification? 

 

( )CfX c ⋅= π21
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PART 2  AN RL CIRCUIT 
PROCEDURE  
1. Set up the circuit with a 10 Ω resistor in series with a current probe and a 5.0 mH inductor. as 

shown in Figures 4 and 5.  

 
   Figure 4               Figure 5 
 
2. Connect the voltage and current probes to the interface and start the data-collection program. 

Change the data-collection rate to 10,000 samples/second and the duration to 0.02 seconds. 

3. Start the power amplifier output using a sine wave output with the frequency set to 100 Hz 
and an amplitude of 2.0 volts.  

4. From your Pre-Lab Investigation, consider how the circuit you have constructed should 
behave. Now that you have connected this circuit to an AC voltage source, would you expect 
the current to be greater at low or high frequencies?  

5. Close the switch and begin collecting data. When data collection stops, use the Statistics tool 
to determine the maximum value of the potential and the current for the run; record these 
values in your notebook. 

6. Continue collecting data in this way until you have potential and current values for  
6–7 frequencies ranging up to 1000 Hz. 

 
EVALUATION OF DATA 
1. For each of your runs, the maximum voltage should have remained roughly the same. How 

did the maximum current in the circuit vary with frequency? Write a statement that describes 
the relationship you found. 

2. Impedance is the general term for the opposition to the current due to the resistance and 
reactance of circuit elements. In this step, you will determine how the impedance varies with 
the frequency. For each frequency, determine the value and units of the impedance of the 
circuit by dividing the maximum value of the potential by the maximum value of the current.  
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3. Disconnect the probes from the interface and choose New from the File menu. In the table, 
manually enter values so as to produce a graph of impedance vs. frequency. Instead of Hz, use 
1/s as the units for frequency.  

4. At first glance, the relationship between impedance and frequency might appear to be linear. 
Closer inspection shows that this is not the case. Rather than performing a curve fit on the 
data, take steps to modify one of the variables so as to produce a more linear graph. You may 
find it necessary to modify the variables on both axes to achieve this end. When you have a 
linear graph, record the equation of the best-fit line. 

5. Relate the y-intercept of your graph to the resistance of the circuit; be sure to include the 
resistance of the inductor.  

6. The textbook definition of inductive reactance is . Relate this equation to the 
equation of your best-fit line. What does the slope of your equation indicate about your 
inductor? 

 
PART 3  AN RLC CIRCUIT 
PROCEDURE  
1. Set up the circuit as shown in Figure 6. This is an RLC circuit, containing a capacitor, an 

inductor, a current probe, and a mini lamp, which serves as the resistor. 

 
Figure 6 

2. Connect the current probe to the interface and start the data-collection program. Change the 
data-collection rate to 10,000 samples/second and the duration to 0.02 seconds. 

3. Start the power amplifier output using a sine wave output with the frequency set to 100 Hz; 
increase the amplitude to 5.0 volts. Close the switch to complete the circuit. 

4. Collect data and, as you have done before, determine the maximum current. Record this value 
in your lab notebook. 

5 Repeat Step 4 until you have data for at least eight frequencies ranging up to 1300 Hz. 

6. Disconnect the probe from the interface and choose New from the File menu. In the table, 
manually enter values so as to produce a graph of current vs. frequency. Examine your graph 
and determine the frequency at which the current in your circuit was greatest. 
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7. Use the frequency controls of the program you used to control the power amplifier to try 
different frequencies while watching the lamp. Focus your investigation in the region where 
the current was highest. Find the frequency that causes the lamp to glow most brightly. This is 
the resonant frequency of your RLC circuit. 

8. Once you have determined the resonant frequency of your circuit, place the powdered iron 
core inside the coil of your inductor. Note the effect this has on the brightness of the bulb. 
Check to see if the resonance frequency has changed. 

 
EVALUATION OF DATA 
1. An RLC circuit can be considered to be analogous to a damped spring/mass combination 

moving in simple harmonic motion. Like the spring/mass combination, it has a resonant 
frequency at which it absorbs outside energy most readily. In this part of the experiment, you 
found this resonant frequency for your RLC circuit. Resonance occurs when the impedance of 
the circuit is a minimum. For RLC circuits, impedance is defined as 

 

The value of impedance reaches a minimum when the inductive reactance and the capacitive 
reactance are equal. Using the equations for capacitive and inductive reactance, derive an 
equation to calculate the resonant frequency for an RLC circuit. 

2. Using the labeled values for the capacitor and inductor you used, calculate the expected 
resonant frequency for your circuit. 

3. How does your measured resonant frequency compare with the calculated value? What 
factors could explain any difference? 

4. Can you explain the change in the bulb brightness when you placed the metal core into the coil 
of the inductor? 

 
EXTENSIONS 
1. Consider the RLC circuit below. 

 

 The low-voltage AC power supply powering the circuit can change frequencies over a wide 
range. At a particular frequency, lamps A and B are equally bright. What happens to the 
brightness of the lamps if you increase the frequency? Explain. 
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2. To the circuit and software setup from Part 3 (the RLC circuit with the lamp), add the voltage 
probe connected across the terminals of the power amplifier. This will enable you to study the 
phase relationship between the current and voltage waveforms. Since both current and voltage 
are graphed using the same time scale, you can easily see how the two compare over time. 
Here are some questions to investigate:  
a. Begin with the resonant frequency. Describe the phase relationship between the current and 

voltage waveforms. 
b. Decrease the frequency by a few hundred hertz. Describe the phase relationship between 

the current and voltage waveforms. If they are not in phase, is the current peak leading or 
following the voltage peak; i.e., which occurs first? 

c. Repeat Step b with a frequency a few hundred hertz above the resonant frequency. 
Describe the phase relationship between the current and voltage waveforms. 

 
3. How can you best determine the inductance? Calculate the inductance of your coil with a 

metal core added. 
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